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Chapter 1: System Overview

The AP-WM is a field telemetry unit for automated remote meter reading (AMR),
based on the general purpose AP-TX Remote Unit. The unit is designed to operate
in a “fixed network™ configuration, which proves highly cconomical, owing to the
large reception range achieved while maintaining high reliability of the
communication link.

The network operates in the ISM (Industrial, Scientific, Medical) frequency range of
903.6 - 926.2 MHz, utilizing Direct Sequence Spread Spectrum communication
technology. The combination of special frequency band and innovative technology
provides important benefits. Among these are:

¢ Reduced infrastructure costs

e Fast data rates

e Interference immunity

¢ Extended range

e Secure communication

¢ Unlicensed operation in many countries

The network’s three main components are its regional Control Center. Base Stations
and Remote Units.

The Control Center

The Control Center is the nucleus of the nctwork, serving as the system’s
command and control site. It receives messages {rom the Remote Units via the
Base Stations on the Uplink network. The Center performs the following
functions:

e Controlling and monitoring of Base Station receivers and Remote Unit
transmitters.

e Managing communication with the client application.

The Control Center software enables the operator to monitor system operation,
change operating parameters and to control the various components by mcans
of a series of user friendly screens, menus and graphs.

")
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Chapter 1. System Overview

The Base Stations

The system of Base Stations provides the link between the Remote Units and
the Control Center. The Basc Stations receive Uplink transmissions from the
Remote Units. They perform the digital signal processing necessary to
despread the signal, which is then conveyed to a host PC and on to the Control
Center via a dedicated line.

The Remote Units

The Remote Units transmit RF signals to the Base Stations. Their operation 1s
controlled by a microcontroller. In order to maximize battery life, the unit
remains in “power down” mode whenever it is not receiving or transmitting
data.

About This Manual

This manual guides the user with information about the transmitter unit, ifs
installation and configuration procedureboth for persomnel engaged in operating the
network and for installation and maintenance technicians.

"The information presented in this manual is organized as follows:

¢ Chapter 2, Remote Unit Description, describes the Remote Unit and its
sub-components and functions.

e Chapter 3, Installing the Remote Unit, details the installation procedures for
the Remote Unit.

¢ Chapter 4, Operating the System, sets out detailed operating procedures
together with an explanation of the software.

Conventions

To help you interpret information correctly, this manual uscs consistent text
formats for different information. These conventions are explained as follows:

Bold Courier Font Text that must be typed exactly as it
appears, ¢.g. AptelPc.exe

ALL CAPITALS Acronyms and abbreviations. ¢.g.  ACK,
AGC.

First Letter Capitals Technical terms related to the APnet
system, e.g. Base Station. Frequency
Sweep.
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FCC Requirements

This equipment has been tested and found to comply with the limits for a class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation.

This equipment generates, uses and can radiate frequency energy and if not
installed and used in accordance with the instructions. may cause harmful
interference to radio communication. However. there is no guarantee that
interference will not oceur in a particular installation. [f this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on. The user is encouraged to try to correct the
interference by one of the following measures:

e Reorient or relocate the receiving antenna.
o Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different trom that to
which the receiver 1s connected.

e Consult the dealer or an experienced radio/TV technician for help.
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The AP-WM

The unit includes a support board (spacer), batteries. a shielded Direct Sequence
Spread Spectrum (DS SPSP”) transmitter and CPU circuit, an /O circuit and a
printed antenna, fitted in a plastic spray-proof (IP-64) box. The /O circuit translates
pulses of dry contact, to digital signals stored by the unit. The dry contact pulses are
generated by a magnetic interface to a water meter, or any other pulse generating
interface.

The AP-WM is a fully programmable unit. Programming is performed via an RS5232
serial port, using an RJ-45 connector on the umit’s board. The unit can also be
programmed through a magnetic loop interface, provided as an option. The units are
supplied with simple operator software, to enable initialization and service checks on
the field. The unit transmits periodically, at intcrvals programmed prior to operation.
The data transmitted by the unit includes:

o Unit identification

* Meter identification (a separate message 1s initiated for each meter connected to
the unit)

e Current reading of the meter

e Factor used by the meter (e.g. a reading of 1234 with a factor of 10 represents
actual consumption of 123.4 volume units - m* or {1°)

e Tampering information - magnetic tamper and cut-wire tamper are alerted by the
unit immediately

Components

The Unit consists of two modules:
e [/O (input/output) module, which may include a paging receiver.
e Transmitter module, which includes the following components:

- Microcontroller
— ASIC (Application Specific Integrated Circuit)
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— Transmitter

— External memory

The I/OQ (Input/Output) Module

The I/O module conveys logical, digital and power inputs to the unit’s
transceiver, and carries signals and messages trom the microprocessor to the
apphcation. It thus provides the physical interface with the application and the
connection with the power supply. The application iterface includes a
terminal block with 12 inputs. that can be connected to up to four pairs of “dry
contact”™ switches and their ground connection.

The Microcontroller

The 8051 family microcontroller controls the transmitter’s operation, and
monitors the message receive process. It also performs sampling of the
application’s inputs through the application interface and controls the
application’s operating state.

In order to save battery power, a specialized circuit in the [/O module
automatically turns the microcontroller circuit’s power down. In this mode
current consumption is reduced to a minimum, cnabling long battery life. The
circuit is activated only by an “event,” which is identified when one of the
following happens:

e Input is received through the serial port from a PC or similar source.

e The timer for telemetry transmissions has timed out

» A switch has been closed on one of the inputs of the terminal block

The Transmitter

Aptel’s transmitter transmits messages to the Base Stations by means of Direct
Sequence Spread Spectrum technology in the 900 MHz frequency range. Its
transmission power is 1 watt - the maximum allowed for non-licensed ISM

transmission.

Each bit of information is multiplied by the length of a pseudo-random
sequence. The transmission length of each bit thus equals the length of the
sequence (255 bits). As a result, the transmission is spread over a wide
spectrum. The spreading process is performed by an Aptel ASIC.

I~
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Chapter 2 Remote Unit Description

Transmission is initiated in one of the following ways:

¢ Cyclical initiation - messages are transmitted at regular intervals.
e Status Alert - tamper inflicted on the Unit.

¢ User initiation - a request entered on a PC connected to the serial port.
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Installing the AP-WM

Installation Kit

¢ Four mounting screws and wall inserts. or pipe mounting kit

» Installation template

Required tools

e 47 flat screwdriver
¢ Phillips 47 screwdriver

Mounting the AP-WMUnit on the Wall

1. Mount/connect the inputs to the proper devices (e.g. water meters).

[

Choose a convenient position for the Unit.

Mark the position of the holes to be drilled on the wall. using the template.

L2

4. Drill the four holes and insert the wall inserts.

5. Open the unit’s lid and screw in the mounting screws. Secure the unit but
do not overtighten.

6. Program the Unit (if required) via its RS232 connection.

7. Close the Unit lid.

Note:
When programming, make sure that COM1 s dedicated to the RS-232 channel
between the transceiver and the host PC, and is not used for any other purpose.
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Installing the Software

The software used in order to program the Unit is provided on a 3.5” diskette
containing;
e Host PC software “tx126a.exe”

e Auxiliary software “menul.rez”

Note:
The software runs under M5 - DOS. Make sure that this operating system is

available on the host PC.

To install the software:
I. Copy the following files from the 3.57 diskette to the host PC root
directory:

o tx126a.exe

s menul.rez

2. Type tx126a and press Enter; the Main Screen appears and the command
box opens.

(9]
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Chapter 4: Operating the System

This chapter describes in detail the operation of the Remote Unit. It includes a
description of the user interface and operating instructions.

Operating the AP-WM

With Aptel’s remote unit software you can:

¢ Read, set and update transmitter parameters

* Send messages

The Transmitter Parameters Main Screen

Figure 4 - 1 shows the Main Screen as it appears when you operate the
software. For information about installing the softwarce, sce Chapter 3.

Figure 4 - 1: The Transceiver Parameters Main Screen

The Menu Bar Displays 7 menus and a real time clock. When
clicked with the left mouse button, the menus

open to display windows and dialog boxes.
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Chapter 4. Operating the System

The Transceiver Appears as a background window. When
Parameters Window  clicked, the window is activated, and allows vou
to enter or change parameters.

The Commands Appears as a foreground window. Allows you to
Dialog Box enter and send commands,
The Hot Key Bar Displays hot keys for exiting the program and

closing a window,

You can use both the mouse and the keyboard to move around in a window.

» To move the cursor to the Menu Bar, press the F10 key.
e To bring a window to the front, click it or press the F6 key.
e To move between fields in a dialog box, press the TAB key.

» Dialog box commands have their first letters highlighted. To choose a
command, press ALT + (highlighted) letter.

The various windows. boxes and features you can access from the Menu Bar
are listed below:

Menu Access to

= Video mode; About: Calculator; Calendar

File View file; Change Dir; DOS shell; Exit
Commands Commands dialog box

Reports Report window: Message window: Save reports
Telemetry Open; Save; Restore

Window Next: Zoom: Cascade; Tile

Option Colors; Graphic
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Windows, Boxes and Features

= Menu

Figure 4 - 2: The = Menu

Video mode Reduces font size to include more information
on the screen. To return to normal mode, click
Video mode again.

About General information about the software.

Calculator Enables use of built in calculator, using the
mouse only.

Calendar Opens multi-year calendar with current date

highlighted. To move between months, use
up/down direction keys.

File Menu

TRAMSCETVER |

Figure 4 - 3: The File Menu

View File Displays the Open File dialog box. The status
bar shows file name, stze in bits and creation

date. To open a file. type in the file name or
choose a file from the Files list and click Open.
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Change dir. Displays the Change Directory dialog box.
which includes a Directory Name list box and
the corresponding Directory Tree display. To
change the directory, choose a directory from the
list and click “Chdir”.

DOS shell Enables you to work in DOS.

Exit Enables you to exit the program.

Commands Menu

Open Commands Opens the Commands dialog box. which

Dialog displays a list of commands that you can use to
control the transmitter’'s operation and to
configure its parameters. See below for details.

Reports Menu

Figure 4 - 4: The Reports Menu

Open Report Opens the Report window, which displays
Window information about special events, under the
headings Time, Code and Description.

Open Message Opens the Message window, which displays

Window details of messages recetved and time of
transmission.

Save Report Opens a window that allows vou to save the
report under a name of vour choice by clicking
OK.
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Telemetry Menu

Figure 4 - 5: The Telemetry Menu

Open Telemetry Opens a window displaying information about
Window the transceiver’s general parameters.
Save Telemetry Opens a dialog box that allows you to save
Window telemetry files. Enter a file name in the Name
field, or select a file from the Files list and click
OK.
Restore Telemetry Opens a dialog box that allows you to restore
Window telemetry files. Enter a file name in the Name
field, or select a file from the Files list and click
OK.
Window Menu

Figure 4 - 6: The Window Menu

Next Brings the next window to the front of the
display.

Zoom Zooms in and out of open windows.

Cascade Arranges open windows one below the other.

Tile Arranges open windows one next to the other.
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Options Menu

Figure 4 - 7: The Options Menu

Colors Opens the Colors dialog box. In this box you
choose foreground and background colors for
different groups of items.

Graphic Opens the Graphic dialog box. In this box you
change the graphic representation of the open
windows.

Commands List (accessed from Command dialog box)

Ve bl 2Ba
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Figure 4 - 8: The Commands List

Transmit Data Sends the default message to the air. The
message structure is programmed to the unit and
includes the unit 1D, readings and status flags.
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Chapter 4, Opcrating the System

Read Configuration  Reads the current configuration and presents the
parameters on the main window.

Reset Water Meter  Resets to zero the water meter readings.

Readings

Set Unit I:nables the user to program the operator number

Configuration (when scveral operators exist in the same area)
and the Tamper Mode (Magnetic & Cut Wire, or
Magnetic Only), and to set which inputs
connected to the unit are valid (out of the four
available inputs)

Set and Read Opens a window showing the current interval

Timing Parameter between consecutive telemetry messages and
allowing programming of that parameter. A
value of zero turns the transmitter off,

Set Meter Izach meter connected to the Unit is programmed

Parameters to a name, number, current reading, factor and
meter type (water/electric/gas).

Port Choice of connection to COM1 or COM2 of the

host PC
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